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About This Book 

This guide explains how to install, build, and execute Windows® CE 5.0  and Windows 
Embedded CE 6.0 OS images for the 3-Stack board, using the Freescale i.MX31 3-Stack 
Windows CE Multimedia Framework Software Development Kit (SDK).   

Audience 

This document is intended for software, hardware, and system engineers who are planning to use 
the product and for anyone who wants to understand more about the product. 

Organization 

This document contains the following chapters. 

Chapter 1 Explains how to install/uninstall the SDK. 

Chapter 2 Explains how to build Windows CE OS images using the BSP.  

Chapter 3 Explains how to test the multimedia components that you install. 

Conventions 

This document uses the following conventions: 

Courier Is used to identify commands, explicit command parameters, code 
examples, expressions, data types, and directives. 

Italic Is used for emphasis, to identify new terms, and for replaceable command 
parameters. 

References 

The following documents were referenced to build this document. 

1. i.MX Hardware User’s Guide 

2. i.MX Advanced Toolkit Standard Version User’s Guide 

3. i.MX31 PDK 1.4 Windows CE 5.0 User’s Guide 

4. i.MX31 PDK 1.5 Windows Embedded CE 6.0 User’s Guide  
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Chapter 1 
Installation 

The Freescale Multimedia Framework Software Development Kit (SDK) is a collection of 
binary, code, and support files that you can use to create Windows CE OS images for the i.MX31 
3-Stack board. The SDK is distributed as a single archive EXE (.exe) file. 

There are two steps to perform for the installation: first, install the i.MX31 3-Stack Board 
Support Package (BSP), and then install the SDK into the Windows CE source code tree and the 
Platform Builder development environment. 

1.1 Installing the BSP 

To install the BSP, use these steps: 

1. Confirm that the BSP version is PDK1.2 version or above. 

2. Follow the steps in Chapter 1 of the i.MX31 PDK 1.4 Windows CE 5.0 User’s Guide or 
i.MX31 PDK 1.5 Windows Embedded CE 6.0 User's Guide. 
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1.2 Installing the SDK 

To install the SDK, use these steps: 

NOTE 

Before installing the SDK, save any modified files and close 
the sample workspace, because the Installer will modify the 
file of the sample workspace project. 

1. Run the installation execution package. 

The Setup Wizard screen is displayed (Figure 1-1). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1-1 Setup Screen 
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2. Click Next. 

The Choose Components screen is displayed (Figure 1-2). 

 

 

 

 

 

 

 

 

 

 

 

 

 

.  

3. Under Platform Choose, select iMX31_3DS_CE500 or iMX31_3DS_CE600. 

 

Figure 1-2 Choose Components 
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4. Click Next. 

The installation location screen is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. Under Destination Folder, set the path of the destination folder for the SDK installation. 
By default, the multimedia framework SDK will be installed in the following path:  

“$(_WINCEROOT)\Platform\<platform_name>\src\Multimedia" 

where: 

 $(_WINCEROOT) is the path of your Windows CE root folder – “WINCE500” or 
“WINCE600” 

 <platform_name> is the name of the 3-stack platform BSP directory – “3DS” for 
i.MX31 3-stack Windows CE 5.0 BSP, “iMX313DS” for i.MX31 3-stack Windows 
Embedded CE 6.0 BSP 

6. Continue with the installation wizard until the installation is complete.  

 

Figure 1-3 Selecting the Installation Location 
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7. In the final installation window (Figure 1-4) you can select whether to do a clean build for 
the Windows CE OS Image automatically. 

 If Make Run-time Image (Nk.bin) is selected, the entire image build procedure, 
which includes the CSP build, BSP build, and SYSGEN, will be implemented 
automatically. 

 During the automatic build, all of the FSL developed multimedia components are 
included in the OS Image by default. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1-4 Completing the Installation 
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1.2.1 Checking the Installation 

This section explains how to ensure that the multimedia framework SDK was installed 
successfully. The installer copies the Multimedia SDK folder into the BSP code tree: 

• For Windows CE 5.0, the folder is copied to \WINCE500\platform\<platform>\src  

• For Windows Embedded CE 6.0, the folder is copied to 
\WINCE600\platform\<platform>\src 

1.2.1.1 Check the SDK folder in the BSP code tree 

The SDK code tree architecture is shown in Figure 1-5. The table that follows describes the 
folder contents. 

 

 

 

 

 

 

 

 

 

 

 

Folder Contents 

API_include This folder contains the global header files of multimedia DirectShow DMO and Filters. 

components This folder, with its audio, video, parser, and image subfolders , contains the DirectShow DMO 
and Filters source code of multimedia components. 

core_libs This folder contains header files and library binaries of multimedia components. 

docs This folder contains API document, Datasheet and release notes of all of the components. 

misc This folder contains the *.reg and *.bib file required by platform builder. 

bin500 and bin600 These folders contain DLL and EXE binaries, which are built by the components’ source code. 

 

Figure 1-5 SDK Code Tree 
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1.2.1.2 Check the BSP modification performed by the installer 

The SDK installer modifies the BSP to support the Freescale multimedia components.  

To check the BSP modifications, use these steps: 

1. In the bsp_cfg.h file under $(_WINCEROOT)\ platform\<platform>\src\inc\, check 

that the line BSP_OAL_DISABLE_ALIGNMENT_FAULT definition has been 
uncommented as follows: 

#define BSP_OAL_DISABLE_ALIGNMENT_FAULT 

2. In the same bsp_cfg.h file , check that the line 

BSP_VID_MEM_CACHE_WRITETHROUGH has been defined as TRUE, as 
follows: 

#define BSP_VID_MEM_CACHE_WRITETHROUGH TRUE 

3. In the platform.reg file under $(_WINCEROOT)\ platform\<platform>\files\, check 
the following line was added: 

#include "$(_TARGETPLATROOT)\src\Multimedia\misc\fslmm_mx31.reg" 

4. In the platform.bib file under $(_WINCEROOT)\ platform\<platform>\files\, check 
that the following line was added: 

#include "$(_TARGETPLATROOT)\src\Multimedia\misc\fslmm_mx31.bib" 

5. In the directx.bib file under $(_WINCEROOT)\ public\directx\oak\files\, check that 
the following line as below has been commented as follows: 

;wmadmod.dll    $(_FLATRELEASEDIR)\wmadmod.dll      NK  SH 

1.2.1.3 Check the workspace modified by the installer 

The SDK installer modifies the Platform Builder’s workspace to support the Freescale 
multimedia components.  

To check the workspace, use these steps: 

1. In OSDesign View, check that the following DirectShow system components of the OS 
Build were added or removed, as indicated: 

 Added - all components in Core OS  > CEBASE  > Graphics and Multimedia 

Technologies -> Media -> DirectShow 

 Added - the component Core OS  > CEBASE  > Graphics and Multimedia 

Technologies  > Media  > Media Format  > MPEG-1 Parser/Splitter  

 Added - the component Core OS  > CEBASE  > Graphics and Multimedia 

Technologies  > Media  > Media Format  > AVI Filter  



 

                 Freescale Semiconductor 
    i.MX31 PDK 1.5 Windows Multimedia Framework User's Guide, Rev 1.0  

1-8 

 Added - the component Core OS  > CEBASE  > Graphics and Multimedia 

Technologies  > Media  > Audio Codecs and Renderers > Wave/AIFF/au/snd File 

Parser 

1.2.2 Removing an Existing Installed SDK 

This section explains how to remove an installation of the SDK from the Windows CE source 
code tree and Platform Builder development environment. 

NOTE 

Before uninstalling the SDK, save any modified files that you 
want to keep to a protected location, because uninstalling the 
SDK will remove all files that were populated by the Installer. 

To remove an SDK installation, use these steps: 

1. Close Platform Builder.  

2. Click Start > Settings > Control Panel > Add or remove Programs.  

 The Add or Remove Programs dialog is displayed. 

3. Remove the SDK. 

4. Manually remove the remaining SDK files and directories.  

$(_WINCEROOT)\Platform\<platform_name>\src\Multimedia 
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Chapter 2 
Building OS Images 

After completing the SDK installation, you can use the sample workspace to build a Windows 
CE OS Image based on the installed SDK. You may add or remove image build components. 

2.1 Working with Multimedia Components 

The multimedia components are located in the Windows Catalog. You import the catalog, and 
can then add the components to the OS Image build. 

2.1.1 Importing the Windows CE 5.0 Catalog 

To import the Windows CE 5.0 catalog, use these steps: 

1. In Platform Builder, click File > Manage Catalog Items.  

The Manage Catalog Items dialog is displayed. 

2. Click Import. 
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3. The Import Catalog Items window is displayed (Figure 2-1). 

 

 

 

 

 

 

 

 

 

 

 

4. Select WINCE500\PUBLIC\COMMON\OAK\CATALOG\CEC\Multimedia-iMX313DS.cec  

5. Click Open, and then click OK to import the catalog. 

 

Figure 2-1 Multimedia Catalog  
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6. In Platform Builder, click View > Catalog to view the imported multimedia catalog 
items. 

To view all of the multimedia components developed by Freescale, click Catalog > 

Third Party > Freescale i.MX31 3DS MMSDK (Figure 2-3). 

 

 

 

 

 

 

 

 

 

 

 

 

7. To add a multimedia component, right-click a component in the Catalog window, and 

then click Add to OS. 

 

Figure 2-2 Windows CE 5.0 Catalog 



 

                 Freescale Semiconductor 
    i.MX31 PDK 1.5 Windows Multimedia Framework User's Guide, Rev 1.0  

2-4 

2.1.2 Importing the Windows Embedded CE 6.0 Catalog  

For Windows Embedded CE 6.0, the multimedia catalog is automatically imported when the sample 
workspace is opened. You use Platform Builder to find the SDK catalog. 

To view the catalog, use these steps: 

1. Click View > Other Windows > Catalog Items View. 

The Catalog Items View dialog is displayed (Figure 2-3). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. To view the multimedia components, open Third Party > Multimedia > Freescale 

i.MX31 3DS MMSDK. 

3. To add a multimedia component, just select the associated check box. 

2.2 Building OS Images 

This section explains how to build the installed multimedia components in the Windows CE 
workspace.  

 

Figure 2-3 Windows Embedded CE 6.0 Catalog 
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2.2.1 Building Multimedia Components in a Windows Workspace 

2.2.1.1 Building all components simultaneously 

To build all of the installed components at once, use these steps: 

1. Go to the Solution Explorer View, and then open the Multimedia project in the folder 

Platform > MX31 > SRC. 

2. Right-click on the Multimedia project, and then select Rebuild. 

This builds all DLL and EXE binaries in the bin500/bin600 directories under the 
Multimedia folder in the BSP code tree. 

2.2.1.2 Building individual components 

To build individual components, use these steps: 

1. In the project window, open the individual component subproject in the Multimedia 
project 

2. Right-click an individual component’s sub-project, and then select Rebuild 

This builds the DLL and EXE binaries in the bin500/bin600 directories under the 
Multimedia folder in the BSP code tree. 

2.2.2 Building an Image in Platform Builder 

For instructions for building OS images using Platform Builder, see the i.MX31 PDK 1.4 

Windows CE 5.0 or i.MX31 PDK 1.5 Windows Embedded CE 6.0 User's Guide. 

2.2.3 Building an Image using the Command Line 

The SDK installation provides the fsl_mmfmwk_build.bat script, which builds the OS image. 
You can run this script during the last installation step or in the command line after installation. 

To run the script in the command line, follow these steps: 

1. Open the command console on your PC. 

2. Go to the $(_WINCEROOT)\ platform\<platform>\src\Multimedia\ directory.  

3. Run fsl_mmfmwk_build.bat. 
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Chapter 3 
Using the Test Procedures 

This chapter explains how to test the Freescale multimedia components in the Windows CE OS. 
The image was built as described in chapter 2.  

3.1 Audio Decoder Test 

To perform this test, use the Windows CE Media Player to playback the audio files. 

3.2 Video Decoder Test 

To perform this test, use the Windows CE Media Player to playback the video files. 

3.3 Image Decoder Test 

To test image decoders, use the test applications that are built into the Windows CE OS image 
when the decoder component is added from Catalog during the image build procedure. Double-
click the image file to display the image.  

Supported image file extensions: 

• *.bmp for BMP decoder 

• *.gif for GIF decoder 

• *.jpg for JPEG decoder 

• *.png for PNG decoder 

Image display is also supported by command line. To display an image, run the associated 
command: 

Image 

Type 

Command 

BMP fsl_bmp_img_lib_test.exe <image_file_name> 

GIF fsl_gif_img_lib_test.exe <image_file_name> 

JPEG fsl_jpeg_img_lib_test.exe <image_file_name> 

PNG fsl_jpeg_img_lib_test.exe <image_file_name> 

NOTE 
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If JPEG thumbnail image exists, JPEG image decoder test 
application will display thumbnail image after closing 
primary image display window. 

3.4 MP3 Encoder Test 

The test application for an MP3 audio encoder is built into the Windows CE OS image, when the 
MP3 encoder component is added from the Catalog during the image build procedure.  The test 
application supports the WAV file input. 

To execute the test bench, run the following at the command line: 

fsl_mp3_enc_dmo_test.exe <input file> <output file> <Encoder Configuration> 

The <Encoder Configuration> parameters are optional, and described as follows: 

[-b<bps>] [-s<samplerate>] 

 

Arguments Description 

-b<bps> Bit rate for the encoded mp3 bit stream (default 128000), bit/second in Unit. 

Accepted values:  

32000, 40000, 48000, 56000, 64000, 80000, 96000, 112000, 128000, 160000, 192000, 
224000, 256000, 320000 

-s<samplerate> Sample rate for the encoded mp3 bit stream (default 44100), sample/second in Unit 

Accepted values:  

32000, 44100, 48000 

 

Refer to the following command line for information. 

fsl_mp3_enc_dmo_test.exe pcm.wav output.mp3 –b 128000 –s 44100 

NOTE 

The current test application supports the WAV file input. The 
sample rate of an input WAV should be the same as " –s 

<samplerate>".  If the two rates are not identical, the test 
application stop the encode procedure and exits. 

3.5 SBC Encoder Test 

The test application for an SBC speech encoder is built into the Windows CE OS image when, 
the SBC encoder component is added from the Catalog during the image build procedure.   
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The SBC Encoder test application provides a set of arguments to set the configuration of the 
encoder. 

To execute the test, run the following at the command line: 

fsl_sbc_enc_test.exe < input_file> [-h] [-l<blk_len>] [-m<mode>] [-o<output_file>] [-

n<subbands> [-p] [–r <rate>] [-b<bitpool>] [-s<sample_freq>] [-f<super_frame_size>] 

Where the input arguments list below: 

Argument Description 

input_file  Name of the input file 

-h Display this command line help and exit 

-l <blk_len block length (4,8,12 or 16) 

-m <mode>          mode (0=mono, 1=dual_channel, 2=stereo) 

-o output_file     Name of the output file.  Output suppressed if unspecified. 

-n <subbands>   number of subbands (4 or 8) 

-p                         Enable psycho-acoustic model [default is off] 

-r <rate Bit rate in bps (cannot be combined with -b option) 

-b <bitpool>       Bit pool value (2 to 250) (cannot be combined with -r option) 

Recommended bit pool value:  

In DUAL MODE,  

if  sample rate==16KHz, bitpool=5*subbands, 

if   sample rate>16KHz,bitpool=4*subbands; 

In STEREO MODE,  

if sample rate==16KHz, bitpool=9*subbands; 

if Sample rate>16kHz,bitpool=7*subbands. 

-s <sampling_freq>     Sampling Frequency (16000,32000,44100, or 48000 Hz) 

-f <super_frame_size> Size of input data frame (e.g. 2048) – optional 

NOTES 

The current test application supports the WAV file input. 

Either bit pool or bit rate must be provided, but not both.  

Super frame size is optional. Encoder operates on data frame 
size that is a product of the number of subbands and number 
of blocks. If input data comes in frames of a certain 
predefined size, then the super_frame_size quantity should 
be set to that size. 

Psychoacoustic model may or may not be used. 
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3.6 WMA8 Encoder Test 

The test application for a WMA8 audio encoder is built into the Windows CE OS image, when 
the encoder component is added from the Catalog during the image build procedure.   

To execute the test, run the following at the command line: 

fsl_wma8_enc_dmo_test.exe <input file> <output file> <Encoder Configuration> 

The parameters for Encoder Configuration are optional, and described as follows: 

[<-a> <AUTHOR>] [<-b> <BITRATE>] [<-c> <COPYRIGHT>]  

[<-d> <DESCRIPTION>] [<-T> <TITLE>]  

The following table describes the parameters. 

Argument Description 

<-a> <AUTHOR> Specifies an array of WCHARs that contains the author information in the ASF header. 

<-b> <BITRATE> Bit rate for the encoded wma bit stream (default 70000). Any value ranging from 
20k(bps) to 211.2k(bps). 

<-c> <COPYRIGHT> Specifies an array of WCHARs that contains the copyright information in the ASF 
header. 

<-d> <DESCRIPTION> Specifies an array of WCHARs that contains the description information in the ASF 
header. 

<-r> <RATING> Specifies an array of WCHARs that contains the rating information in the SF header. 

<-T> <TITLE> Specifies an array of WCHARs that contains the title information in the ASF header. 

<-h> Get the usage of this test bench. 

The following table describes the valid configuration combination for WMA8 Encoder. 

Channels Sample Rate (Hz) Bit Rate (bps) 

22050 22000, 16000, 22000 

32000 22000, 20000 

Mono 

44100 52800, 48000, 35200, 32000 

22500 35200, 32000, 22000, 20000 

32000 52800, 48000, 44000, 
40000, 35200 

44100 221200, 192000, 176000, 
160000, 140800, 128000, 
105600, 96000, 88000, 
70400, 64000 

Stereo 

48000 211200, 192000, 176000, 
160000, 140800, 128000 

 

Refer to the following command line for information. 



 

 

 

 

Freescale Semiconductor 

      i.MX31 PDK 1.5 Windows Multimedia Framework User's Guide, Rev 1.0  

3-5 

fsl_wma8_enc_dmo_test.exe pcm.wav output.wma –b 128000 –d “Freescale test 

music”   

3.7 PEQ Audio Post-processing Test 

The test applications for PEQ audio post-processing fsl_peq_ppp_app_forwmp.exe, will be 
built into the WinCE OS image, when the post-processing component is added from Catalog 
during the image build procedure.   

It is a graphic user interface for users to switch among PEQ profiles and control volume 
dynamically while playback the audio file with Windows CE Media Player. 

IMPORTANCE 

The test applications for PEQ audio post-processing should 
be run before using Windows CE Media Player to playback 
the audio files. Otherwise, PEQ audio post-processing will 
not function. 

To use test application for PEQ testing, follow these steps: 

1. To execute the test application, double-click the executable file or run the following at 
command line: 

fsl_peq_ppp_app_forwmp.exe 

Then the test application window is displayed (Figure 3-1) 

 

Figure 3-1 PEQ Setting 

2. Use Windows CE Media Player to playback an audio file. And keep the test application 
running when audio playback 

3. During the playback periods, you can select different “Premode” dynamically through 
Profile List. The following table describes the Pre-defined profiles are defined. 
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Index Profile Name 

0 Do not select predetermined scenes. (default) 

1 Acoustic 

2 Bass booster 

3 Bass reducer 

4 Classical 

5 Dance 

6 Deep 

7 Electronic 

8 hip hop 

9 Jazz 

10 Latin 

11 Loudness 

12 Lounge 

13 Piano 

14 Pop 

15 R&B 

16 Rock 

17 small speakers 

18 spoken word 

19 treble booster 

20 treble reducer 

21 vocal booster 

22 Flat 

4. Use Attenuation scrollbar to control the volume. 

NOTE 

If the value for attenuation is set too high, the audio output 
would not be pleasing. It is strongly recommended that the 
value of attenuation is set to below -30. 

3.8 Hantro Encoder Test 

The test application for the Hantro MPEG4 video encoder is built into the Windows CE OS 
image, when the encoder component is added from Catalog during the image build procedure. 

The test accepts KEV and YUV formats as input. The test application creates a filter graph where 
the file source filter consumes the raw data to be encoded. The source filter has a macro named 
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SINGLE_FILE, which when enabled, uses the YUV format. If this file is not enabled, you can 
use the KEV format. SINGLE_FILE is enabled by default, and YUV is the default support file. 

To encode the video raw data, run the following at the command line: 

mx31_enc_dshow_testbench.exe <input filename> <output filename> <WIDTH> 

<HEIGHT> <bit rate> <frame rate> <encoder type>  <key frame rate> 

The following table describes the parameters. 

Argument Description 

<input filename> Input file name with full path. 

<output filename> Output file name with full path 

<WIDTH> Width value of the input video¹ 

<HEIGHT> Height value of the input video¹ 

<bit rate> Bit rate value of the output video stream¹ 

<frame rate>    Frame rate value of the output video stream¹ 

<encoder type> Encoder used for encoding: 

1 -- for MPEG4  

2 -- for H.263 

<key frame rate> Key frame rate value of the output video stream  

– every n frames per key frame in unit 

-- n can be 0~2^31-1 

The following table describes the combination of values of <WIDTH> <HEIGHT> <bit rate> <frame 

rate> <encoder type>. 

Line width height 

bit 

rate 

(kbps) 

frame 

rate 

encode

r type 
Description 

1 176 144 64 15 1 MPEG4_SIMPLE_PROFILE_LEVEL_0 

2 160 120 64 15 1 MPEG4_SIMPLE_PROFILE_LEVEL_0 

3 176 144 128 15 1 MPEG4_SIMPLE_PROFILE_LEVEL_0B 

4 160 120 128 15 1 MPEG4_SIMPLE_PROFILE_LEVEL_0B 

5 176 144 64 30 1 MPEG4_SIMPLE_PROFILE_LEVEL_1 

6 160 120 64 15 1 MPEG4_SIMPLE_PROFILE_LEVEL_1 

7 176 144 64 15 1 MPEG4_SIMPLE_PROFILE_LEVEL_1 

8 160 120 128 30 1 MPEG4_SIMPLE_PROFILE_LEVEL_2 

9 176 144 128 30 1 MPEG4_SIMPLE_PROFILE_LEVEL_2 

10 352 288 128 15 1 MPEG4_SIMPLE_PROFILE_LEVEL_2 

11 176 144 384 30 1 MPEG4_SIMPLE_PROFILE_LEVEL_3 
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Line width height 

bit 

rate 

(kbps) 

frame 

rate 

encode

r type 
Description 

12 352 288 384 30 1 MPEG4_SIMPLE_PROFILE_LEVEL_3 

13 352 288 768 30 1 MPEG4_ADV_SIMPLE_PROFILE_LEVEL_3 

14 352 576 3000 30 1 MPEG4_ADV_SIMPLE_PROFILE_LEVEL_4 

15 640 480 4000 30 1 MPEG4_ADV_SIMPLE_PROFILE_LEVEL_5 

16 176 144 64 15 2 H263_PROFILE_0_LEVEL_10 

17 352 288 64 15 2 H263_PROFILE_0_LEVEL_10 

18 176 144 128 30 2 H263_PROFILE_0_LEVEL_20 

19 352 288 128 15 2 H263_PROFILE_0_LEVEL_20 

20 176 144 384 30 2 H263_PROFILE_0_LEVEL_30 

21 352 288 384 30 2 H263_PROFILE_0_LEVEL_30 

22 352 288 2048 30 2 H263_PROFILE_0_LEVEL_40 

23 352 288 4000 30 2 H263_PROFILE_0_LEVEL_50 

24 640 288 4000 30 2 H263_PROFILE_0_LEVEL_60 

25 640 480 4000 30 2 H263_PROFILE_0_LEVEL_70 

3.9 JPEG Encoder Test 

The test application for the JPEG image encoder is built into the Windows CE OS image, when 
the encoder component is added from Catalog during the image build procedure. 

The JPEG Encoder test application can output the encoded data to a file or render it to a screen. 
The input format of the test bench should be in YUV422 in interleaved format. The test 
application provides a set of the arguments to configure the encoder. 

Run the following command in “Command Prompt” to execute the test bench: 

fsl_jpeg_enc _img _lib_test.exe  -yt <yuv_format> -q <quality>  -yw <y_width>  -yh 

<y_height>  -uw <u_width> -uh <u_hegiht>  -vw <v_width> -vh <v_hegiht>  [ –prg]   [-

rm]  [ -ex]  -i <input file > -o <output file> 

The following table describes the parameters. 

Argument Description 

  -yt <yuv_format> Accepted YUV formats: 

• 3 – YU_YV_422_INTERLEAVED 

• 4 – YV_YU_422_INTERLEAVED 

• 5 – UY_VY_422_INTERLEAVED (default) 

• 6 – VY_UY_422_INTERLEAVED 
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  -q <quality> Compress quality can be set the value in the range [0, 100]- (75 is default) 

  -yw <y_width> Y width value in the range [1, 65000] 

  -yh <y_height> Y height value in the range [1, 65000] 

  -uw <u_width> U width value in the range [1, 65000] 

  -uh <u_height> U height value in the range [1, 65000] 

-vw <v_width> V width value in the range [1, 65000] 

  -vh <v_height> V height value in the range [1, 65000] 

  -prg   Enable Progressive Compress method 

  -rm Enable Restart marker 

  -ex Enable EXIF exist 

  -i <input file> Input file name list and path 

-o <output file> Output file name and path 

NOTES 

The current version of the library supports only the 
Interleaved YUV422 format; where the YUV format values 
are 3, 4, 5 and 6. 

3.10 Deinterlacer Enable/Disable 

The Video Post-processor Deinterlacer can be enabled or disabled using the registry key  

[HKEY_LOCAL_MACHINE\Software\FreeScale\Filter\Video\PostProcess\deinterlace] 
Deinterlace=00000000 

where: 

"deinterlace"=dword:00000001 means deinterlacer enable; otherwise it is disabled. 
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Appendix A 
Patches and Fixes 

Upon installation, Freescale patches are automatically installed. However, you may also install 
the patches manually, if you prefer to confirm that they are installed.  

A.1 Unaligned Access Fault Disable 

Applies to: Windows CE 5.0 and Windows Embedded CE 6.0. 

About: The Freescale video decoder requires that the BSP provide memory unaligned access 
without fault.  

Action: Before you build the BSP, perform the following modification:  

1. Open the bsp_cfg.h file, located in: $(_WINCEROOT)\PLATFORM\<platform>\src\inc\ 

2. Uncomment the following line, so that it appears as follows: 

#define BSP_OAL_DISABLE_ALIGNMENT_FAULT 

A.2 Video Memory Cache Policy  

Applies to: Windows Embedded CE 6.0 

About: The Freescale video decoder requires that the cache policy of  the video memory (IPU 
buffer) be write-through. Performance issues will occur with non-cacheable or write-back 
memory.  

Action: Before you build the BSP, perform the following modification:  

1. Open the bsp_cfg.h file in the following directory 
\WINCE600\PLATFORM\<platform>\src\inc\ 

2. In the file, change BSP_VID_MEM_CACHE_WRITETHROUGHBSP_VID_MEM_CACHE_WRITETHROUGHBSP_VID_MEM_CACHE_WRITETHROUGHBSP_VID_MEM_CACHE_WRITETHROUGH to TRUE, as shown: 

#define BSP_VID_MEM_CACHE_WRITETHROUGH TRUE 
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A.3 YV12 Format Display 

Applies to: PDK 1.1 and earlier 

About: The Freescale video decoder output is in YV12 format. The BSPs for PDK 1.2 and later 
support this format in the IPU display driver. For versions PDK 1.1 and earlier, you must modify 
the BSP.  

Action:  

1. Go to the following file: 
$(_WINCEROOT)\PLATFORM\<platform>\Src\Drivers\Ipu\Display\Ddipu_sdc\halsurf.cpp 

2. Comment out the line return DDERR_UNSUPPORTEDFORMAT, as shown: 

if( pDDPF->dwFourCC == FOURCC_YV12) { 

    DEBUGMSG(1, (TEXT("DetectFormat: YV12 surface detected\r\n") )); 

    // remove the filtering of YV12  

    // return DDERR_UNSUPPORTEDFORMAT; 

    *pPixelFormat = (EDDGPEPixelFormat) ddgpePixelFormat_YV12; 

} 

A.4 PF Driver 

Applies to: Windows CE 5.0 and Windows Embedded CE 6.0, PDK 1.1 and earlier.  

If your BSP version is older than BLN_WPDK-CE600_MX31_01.03.00, obtain and apply the 
PF patch for unaligned memory access from the following location: 
http://compass.freescale.net/go/180460188 

About: The Freescale H.264 video decoder uses the post-filtering (PF) hardware for acceleration. 
The PF driver is included in the BSP package and automatically added to the image build.  

Action:  

Prior to performing the image build, use these steps:  

1. Go to the Environment Variable Window. 

2. Add the variable BSP_PF and set the value to 1.  

http://compass.freescale.net/go/180460188
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A.5 Hantro MPEG4 Encoder Driver  

Applies to: Windows Embedded CE 6.0 

If your BSP version is older than BLN_WPDK-CE600_MX31_01.03.00, obtain and apply the 
Hantro encoder patch from: 

http://compass.freescale.net/go/180460188 

About: The Freescale i.MX31 board includes an MPEG4 encoder hardware (Hantro encoder). 
The Hantro driver should be included in the BSP package and must be added to the image build.  
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